Project Application Guidelines

For the

Major New Capacity Program

Project Application Guidelines for New Projects

June 28, 2012
TRAC Application Process for 2012

Considering the current fiscal constraints, TRAC will modify the 2012 application cycle, only accepting applications that meet one of following criteria:

1. The project is an existing TRAC funded project (Tier I, II or III) and additional funds are needed to advance the project to the next stage of development.

2. A new project, which has not previously applied for TRAC funding, demonstrating significant impact to jobs in Ohio and a statewide/regional economic impact.

This guidance applies to Type II – “Long Form” Applications for new TRAC funding requests

Considerations for New Projects

• Project sponsors for new projects are required to complete the full application.

• New projects will be evaluated and scored with accordance with TRAC Policy.

• TRAC and ODOT will review new project applications to determine the need to participate in a regional hearing.

• Given the limited availability of funds, new projects must demonstrate innovative funding solutions and provide more than a minimal amount of local funding contribution and financial support.

• To receive full consideration it is recommended that sponsors clearly outline how the project will improve jobs in Ohio and statewide economic impact.
Frequently Asked Questions and Answers

1. What is the definition of a Major New Project?
The TRAC defines Major New Capacity projects as those projects greater than $12 million which increase the capacity of a transportation facility or reduce congestion. All projects that cost ODOT greater than $12 million, request Major New funding, and add capacity to a transportation facility must come before the TRAC. This definition includes all new interchanges proposed for economic development or local access, any significant interchange modifications, bypasses, general purpose lane additions, intermodal facilities, major transit facilities, or Intelligent Transportation Systems (ITS).

2. Examples of eligible projects:
   - Adding an additional lane on a state highway or interstate
   - Adding an additional lane on bridges
   - New interchanges
   - New facilities that bypass congested state highways or interstates
   - New rail lines for public transportation
   - Capital cost for ITS facilities
   - Intermodal port and rail projects

3. Examples of non-eligible projects:
   - Widen a road from 10-foot lanes to 12-foot lanes
   - Purchasing buses or other rolling stock
   - Turning lane improvements
   - Local road improvements
   - Project with a total project cost under $12 million

4. Who Manages the Major New Capacity Program?
The Major New Capacity project selection process operates under the purview of the Transportation Review Advisory Council (TRAC). The council was established by Ohio Revised Code in 1997 to help ODOT develop and modify a project selection process and which approves major new projects for funding.

The TRAC has nine members and is chaired by the Director of the Ohio Department of Transportation. Six members are appointed by the Governor and one each by the speaker of the Ohio House of Representatives and the president of the Ohio Senate. Members have overlapping terms. The Director provides funds for new construction only after assuring that system preservation needs have been met. The use of the new construction funds is the responsibility of the TRAC, but the TRAC does not have authority over other aspects of the Department of Transportation.
5. **How can I obtain a Major New Project Application?**
   The Major New Project Application can be obtained by downloading it on the ODOT website at [www.dot.state.oh.us/trac/](http://www.dot.state.oh.us/trac/) or by contacting the TRAC Coordinator:

   **Mail:**
   Jim Gates
   Ohio Department of Transportation
   1980 West Broad Street
   Columbus, Ohio 43223

   **Phone/Email:**
   Phone: (614) 752-7468
   Fax: (614) 728-9358
   Email: TRAC@dot.state.oh.us

6. **When are Project Applications due?**
   Project Applications are due no later than August 3, 2012. Please see the Submission Instructions outlined on page 25 of this document for further details.

7. **How are projects nominated for the Major New Program?**
   The TRAC does not initiate projects. It reviews and ranks projects submitted to it. Projects are submitted/nominated by completing the Major New Project Application. Projects may be submitted/nominated by:
   - The Ohio Department of Transportation
   - Metropolitan Planning Organizations
   - County Engineers
   - Transit Authorities
   - County Commissioners
   - Municipalities
   - Port Authorities

8. **When should I submit a TRAC application?**
   The Project Sponsor should submit an application for:
   - Existing TRAC funded project (Tier I, II or III) seeking additional funds that are needed to advance the project to the next stage of development.
   - New projects, which have not previously applied for TRAC funding, demonstrating significant impact to jobs in Ohio and a statewide/regional economic impact which meet the Major New Project definition (see page 3).

9. **What is the difference between the Short and Long Application?**
   Existing TRAC funded project (Tier I, II or III) seeking additional funds that are needed to advance the project to the next stage of development will complete a short application form, updating the milestones and funding plan for the project while identifying State, Federal and local funding. New projects that have not previously applied to TRAC will need to complete the long application.

10. **Should I make a presentation before the TRAC?**
    The TRAC will hold public hearings around the state in September and October. Projects requesting Tier I will be required to participate in a regional public hearing. Projects seeking additional development funds will be evaluated on a case-by-case basis to determine the need to participate in a regional hearing. TRAC and ODOT will review new project applications to determine the need to participate in a regional hearing.
Please review the following guidelines PRIOR to completing the application. The information provided in the following document will guide the applicant step-by-step through the application process.

Note 1:
Information should be entered on the application in the yellow areas only. Please do not edit, modify, or recreate the form. Only the original Excel Application will be accepted for consideration. Also, except where directed, please do not add rows or columns to the tables. Doing so may delay the processing of your application.

Note 2:
Prior to beginning the application, please contact the District to verify the subject project meets the funding eligibility guidelines listed on page 7 (TRAC Funding Eligibility) of the TRAC Policy and Procedures.

Note 3:
Mapping requirements outlined under the Community and Economic Growth and Development Factors are required for submission. An application will be considered incomplete without the associated maps. If a sponsor has questions on what content is required for the mapping, please contact the Office of Systems Planning and Program Management for assistance.

Note 4:
Please do not submit paper copies and/or binders of information. Paper copies of the applications are NOT required. The Department requires the application to be electronic in an effort to minimize preparation expenses and expedite project management, review, and scoring.

Note 5:
Signed (ink) copies of the application are no longer required. The electronic transmittal of data from the sponsor to the Department (i.e. email, DVD, etc) is accepted as an official record of intent. MPO’s will be contacted by the District via email to acknowledge each project (if applicable). Upon receipt and review of the application, the MPO will be asked to respond via email to the District either acknowledging or commenting on the project. The email response will be retained as the official response from the MPO.

Note 6:
Upon completion of the TRAC application, the sponsor shall submit all associated project information directly to the District Office. The District will review the application, mapping, and related attachments and communicate directly with the sponsor regarding any questions. The District Office will be responsible to officially submit the application in electronic format to the ODOT Central Office Server.

Once complete, the District will email the TRAC inbox notifying the TRAC Staff that the application is ready for processing. Applications submitted directly to the TRAC inbox without District review and concurrence will not be accepted.
Download /Access the 2011 TRAC Application

1. Download the current application from the following web link:

   http://www.dot.state.oh.us/trac/Pages/NewTRACApplicationGuidelinesandApplicationForms.aspx

2. Save the application to a local directory on your computer

3. Once the application is saved, open the file using Microsoft Excel

4. The application will open, and the following dialog box will display:

   ![TRAC Form Dialog Box]

5. Select > OK

   **All data will be locked and not able to be edited following August 1, 2012.** The TRAC application may be adjusted on a year to year basis, and the expiration limit will prevent future applications from using previous versions of the Excel file for TRAC submission.

6. Enable the **Macro Option** to ensure the Excel VBA routines function properly per the instructions provided below. **If the Macro Functionality is not enabled, the spreadsheet will not work correctly.**

   a. From the **Excel File Menu** advance the following steps:

   i. Select File > Options > Trust Center > Trust Center Settings

   ![Macro Settings]

   ii. Within the Macro Settings as shown above, Select > Enable all macros > OK
Application Instructions

2012 TRAC Project Application

<table>
<thead>
<tr>
<th>General Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposed TRAC Status</td>
</tr>
<tr>
<td>ODOT District:</td>
</tr>
</tbody>
</table>

**Proposed Status**
Enter “Tier 1” if the request includes funding for construction; otherwise enter “Tier 2”.

**ODOT District**
Enter the ODOT District for the project. *(The field will display a drop down list prompting the user to select their respective District.)*

**County:**
Select the county which the project primarily resides. *(Once the ODOT District is selected, the County field will auto filter the list of counties associated with the respective District.)*

**ODOT PID**
Enter the ODOT assigned five digit Project ID number (or PID). *(Enter only one PID per application.)* PID’s for related projects should be entered in the Project Relationship table, below. If new or additional TRAC funding is being requested for multiple projects/PID’s, submit multiple applications (one application for each project/PID).
Local Jurisdiction
Enter the local jurisdiction where the project primarily resides (i.e. Cities, Counties, Townships, etc)

Facility Name
Enter the route, rail, terminal, or port name by which the project is known. For roadway projects, include the route type (SR – state route; CR – county route; TR – township route) and number, or the local road name.

Principal Agency
Enter agency name of the primary project sponsor. The TRAC discourages members of the general public from nominating projects. Members of the general public who desire a project should secure the support of a local governmental entity as the lead project sponsor to ensure the project is compatible with local planning priorities.

Participating Agencies
Enter agency name(s) all of the project co-sponsors.
Project Sponsor (Contact Person) / Phone Number / Street Address / City / State / Zip / Email Address

Enter the name, mailing address, phone number and email address of the person to be informed of all TRAC actions and public hearings.

Description of Work

In **100 words or less**, describe the basic facts of the work to be performed. Include the descriptions and number of facilities to be constructed/reconstructed.

Purpose and Need for the Project

In **500 words or less**, lay out the purpose and need for the project. This should be copied from an existing planning or environmental document if available.
List all other projects that are related to this project. For example:

- If part of the development for the current project/PID was performed under other projects/PID’s, enter those other projects here
- If the current project/PID is phase of larger group of projects/PID’s, enter all of the other projects in the group here

*Enter one project on each row. Add additional rows as necessary by selecting the following icon located in the right margin:*

<table>
<thead>
<tr>
<th>ODOT PID</th>
<th>Project Name</th>
<th>County</th>
<th>Phases Included</th>
<th>Ex. TRAC Project</th>
<th>TRAC List Date</th>
<th>TRAC List Line No.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>PS  PE  DD  RW  CO</td>
<td>Yes  No</td>
<td>MM/DD/YYYY</td>
<td></td>
</tr>
</tbody>
</table>

**ODOT Project ID**
Enter the ODOT PID number for the related project.

**Project Name**
Enter the related project’s name. Generally the name includes the county, route number and beginning log point (section). The project name should match the project name as it appears in Ellis.

**Phases Included**
Select all of the phases that the project has or will perform. Possible phases are:

- PS – Planning Study
- PE – Preliminary Engineering
- DD – Detailed Design
- RW – Right of Way
- CO – Construction

**Existing TRAC Project**
If this application relates to an existing project on a previous TRAC list, select Yes

**TRAC List Date**
If this application relates to an existing project on a previous TRAC list, enter the publication date of the previous TRAC list.

**TRAC List Line #**
If this application relates to an existing project on a previous TRAC list, enter the line number of the existing project on the previous TRAC list.
Supplemental Information
For purposes of scoring “Community and Economic Development Factors,” the following additional information (maps) must be included with the application. The maps are to be at least 8.5” x 11” but no larger than 11” x 17”. Submit one electronic copy in pdf format.

Project Location Map (Label as #1) is Attached
This map must include an aerial photograph overlay of the area (preferably color), and must show the proposed project location. Also include defined labels for significant existing infrastructure related to the project (i.e. major road names, nearby municipal boundaries) for reference). Map 1 is required and must be included with the application to obtain scoring.

Economic Impact Map (Label as #2) is Attached
This map must denote the project’s immediate economic footprint with a geographic polygon of the general economic influence area. The economic influence area must be defined in cooperation with the responsible local economic development professionals (or state/regional representatives if local economic development professionals do not exist). The map must also label land use by general type (Industrial, Commercial/Office, Commercial/Retail, Residential, Agriculture, Conservation, etc.), and show as applicable – Clean Ohio Revitalization Fund Brownfield Projects, Clean Ohio Assistance Fund Brownfield Projects, Ohio Department of Development Brownfield Revolving Loan Fund Projects, Ohio Job Ready Site Projects, University System of Ohio institutions, private four-year universities, non-profit research institutions, and Ohio Hub of Innovation and Opportunity (OHIO Hub) anchor institutions. As per the Policy & Procedure manual, should the economic influence area be subject to further examination, the TRAC will be the final arbiter of the quality of data submitted by the project applicant. Map 2 is required and must be included with the application to obtain scoring.
Redevelopment Map (Label as # 3) is Attached
This map must show the project location and denote with a geographic polygon the area directly served by the project, consistent with the definition provided under the “Positioning Land for Redevelopment” section on Page 16 of the Policy & Procedures. Additionally, the map must label developed land and undeveloped land within the geographic polygon. If the defined geographic area provided cannot be justified, the default area will be a one-mile radius around the transportation improvement. ODOT Modeling & Forecasting Unit will utilize the geographic polygon provided in Map 3 to model whether the project will reduce fuel consumption and if ozone precursors are predicted to decrease. Map 3 is required and must be included with the application to obtain scoring.

Employment Map (Label as # 4) is Attached
This map should denote the project location and identify major employers by point and label them by legal name. Smaller employers can be grouped and described by business sector. Include the number of jobs associated with each employer or group. The geographic boundary of the area should be the same as the area directly served by the project, as defined in Map 3. Map 4 is required and must be included with the application to obtain scoring.

Land Use Plan (LUP) is Attached
Enter “Yes” or “No” according to whether a comprehensive land use plan, strategic plan, thoroughfare plan, neighborhood plan, or master community plan adopted by the city, county, or township has been included with the application. Although it is permissible to include the entire Plan, only the portion of the Plan applicable to the area served by the project (as defined in Map 3) must be included.

LUP Coordinates w/ Transportation Plan
Enter “Yes” or “No” according to whether the land use plan is coordinated with the transportation plan or project. The Land Use Plan and Maps 1-4 will be used to verify accuracy of the coordination.

Zoning Supports Transportation Plan
Enter “Yes” or “No” according to whether the appropriate city, county, or township has zoning in place that is conducive to the project under consideration. A copy of the adopted zoning is required and must be included with the application to obtain scoring.

On state/RPC/MPO Long Range Plan
Enter “Yes” or “No” according to whether the project is part of a metropolitan planning organization (MPO) long range plan, regional planning commission (RPC) or ODOT’s Statewide Transportation Plan.

% Developed Land (Map 3)
Based on Map 3, calculate the estimated percentage of developed acreage within the geographic area served by the project. For purposes of definition, “developed” land means property that had, or currently has, use as manufacturing, light industrial, warehouse, commercial, or residential development, with associated infrastructure (such as water, sewer, electricity), and which may also be classified as a brown field. “Undeveloped” land means property that was never used for such development, has no buildings, public utilities or
associated infrastructure, and might have had current or former use as cropland, pasture, woodland, or other use that does not include roadway or utility services. Permanently dedicated green space and cemeteries should be subtracted from the acreage of the geographic area.

(It is the responsibility of the local project sponsor to attach the analysis and calculation of the redevelopment percentage to the application.)

Business Data Added to Map 4
Enter “Yes” or “No” according to whether business data (employers with number of jobs) have been labeled on Map 4.

Improves Investment & Employment
Enter “Yes” or “No” according to whether the project increases land value or employment in the area served by the transportation project, considering:

- The extent to which the project serves an Ohio Job Ready Site, as designated by the Ohio Department of Development. The project applicant must demonstrate the project location on Map 2 in relation to the Job Ready Site location, and justify the assertion that the transportation project improves access to the Job Ready Site.
- Evidence of direct private investment in real estate served by the transportation project (within the economic impact area as defined in Map 2). Private investment is eligible if it is from the previous five years or projected for the next two years. Such evidence could include documents from private businesses or other tangible evidence of private party commitment to develop/expand business in relation to the transportation improvement.
- Evidence of employment growth resulting from the transportation project is defined as prospective full-time equivalent; non-construction/non-project related positions that will be created by businesses denoted in Map 4 or proposed business development within the economic impact area denoted in Map 2. Evidence will be required to verify projected employment growth and can take the form of either a survey of businesses or commitment letters from a business.
- Direct local public investment in public infrastructure associated with the project (local roads, sewer, and water) that demonstrates confidence in the private sector’s plans or commitment to build or expand, as associated with the transportation investment.

Sub-county 5 Year Unemployment Rate
Enter the sub-county/project area 5-year unemployment rate as a percentage. If omitted, the 5-year unemployment rate for the primary county will be obtained from the US Bureau of Labor Statistics (www.bls.gov).

Sub-county 5 Year Poverty Rate
Enter the sub-county/project area 5-year poverty rate as a percentage. If omitted, the 5-year poverty rate for the primary county will be obtained from the US Census Bureau (www.census.gov).

(It is the responsibility of the project sponsor to attach documentation that defines the sub-county area, and calculations of the unemployment poverty rate percentages.)
If project connects transportation modes, please explain how
Provide an explanation of how transportation modes will be directly connected by this project. Simply stating the existence of other modal facilities within the project impact area is not sufficient to be awarded points for intermodal connectivity.

### Existing Road Facilities By NLFID

<table>
<thead>
<tr>
<th>ODOT NLFID</th>
<th>Begin Log Point</th>
<th>End Log Point</th>
<th>Primary</th>
<th>Location Termini</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
The ODOT District will enter the ODOT NLFID as required. The local project sponsor is not required to enter the NLFID.

*If the Existing Road Facility is not within the ODOT NLFID Inventory, please locate the facility per the instructions outlined on Page 16.*

**ODOT NLFID**
Enter the ODOT network linear feature identifier (NLFID) which uniquely identifies each road in Ohio. If the NLFID is not known, enter the 3-character county abbreviation along with the route type and number.

**Note:**
Enter one existing road facility per row. Add additional rows as necessary by selecting the following icon located in the right margin:

[Click the Plus Sign Below to Add a Row.]

**Note:**
It is the responsibility of the project sponsor to complete all of the following columns for each existing road facility entered.

**Begin Log Point**
Enter the beginning log point (i.e. mile post) for the roadway improvement.

**End Log Point**
Enter the ending log point (i.e. mile post) for the roadway improvement.
Primary Road
For projects involving more than one road, enter “Yes” or “No” according to whether this road is the primary road being improved. There should be only one primary route.

Location Termini
Enter a brief description of the work limits (i.e. From Broad St. to State St.).

<table>
<thead>
<tr>
<th>Name or Designation</th>
<th>Begin Lat</th>
<th>Begin Long</th>
<th>End Lat</th>
<th>End Long</th>
<th>Primary</th>
<th>Location Termini</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
*If the Existing Road Facility is not within the ODOT NLFID Inventory, please locate the facility per the instructions outlined below.*

Name or Designation
Enter the ODOT network linear feature identifier (NLFID) which uniquely identifies each road in Ohio. If the NLFID is not known, enter the 3-character county abbreviation along with the route type and number.

Begin Lat / Begin Lon / End Lat / End Lon
Enter the beginning and ending latitude and longitude for the existing roadway using Google Maps as outlined below:

- Open Google Maps (Click the Link to the Right) > [Google Maps](#)
- Zoom into the location of the Begin Point of the Facility and right click on the Begin Point.
  - The following dialog box will be displayed with several options. **Select > "What's here?"**
    - The (Latitude, Longitude) values will appear in the Search Field as shown in the screen capture below:
Input these values into the TRAC Application as required.

**Note:**
It is the responsibility of the project sponsor to complete **all** columns for each existing road facility entered.

**Primary Road**
For projects involving more than one new road, enter “Yes” or “No” according to whether this road is the primary new road being constructed.

**Location Termini**
Enter a brief description of the limits of new roadway construction (i.e. From Broad St. to State St.).

The Google Map associated with the project limits will automatically hyperlink the location to the text.

**Note:**
Enter one existing road facility per row. Add additional rows as necessary by selecting the following icon located in the right margin:

Name or Designation
Enter the ODOT network linear feature identifier (NLFID) which uniquely identifies each road in Ohio. If the NLFID is not known, enter the 3-character county abbreviation along with the route type and number.
Begin Lat / Begin Lon / End Lat / End Lon
Enter the beginning and ending latitude and longitude for the new roadway using Google Maps as outlined below:

- Open Google Maps (Click the Link to the Right) > Google Maps
- Zoom into the location of the Begin Point of the Facility and right click on the Begin Point.
  - The following dialog box will be displayed with several options. Select > "What's here?"
  - The (Latitude, Longitude) values will appear in the Search Field as shown in the screen capture below:

![Google Maps Location Search](image1.png)

  - Input these values into the TRAC Application as required.

*Note:*
The responsibility of the project sponsor to complete all columns for each new road facility entered.

**Primary Road**
For projects involving more than one new road, enter “Yes” or “No” according to whether this road is the primary new road being constructed.

**Location Termini**
Enter a brief description of the limits of new roadway construction (i.e. From Broad St. to State St.).
The Google Map associated with the project limits will automatically hyperlink the location to the text.

**Note:**
Enter one existing road facility per row. Add additional rows as necessary by selecting the following icon located in the right margin:

![Click the Plus Sign Below to Add a Row.]

<table>
<thead>
<tr>
<th>Transit Facilities</th>
<th>Transit Type and Route/Name</th>
<th>Peak Hour Ridership (Riders)</th>
<th>Existing Capacity (Seats)</th>
<th>Added Peak Hour Capacity (Seats)</th>
<th>VMT Reduction (VMT)</th>
</tr>
</thead>
</table>

**Transit Type and Route/Name**
Enter the transit type (rail, bus) and route/name associated with the transit facility.

**Peak Hour Ridership**
Enter the element ridership during the peak work commute periods (i.e. when highway V/C ratios are measured).

*(It is the responsibility of the project sponsor to attach documentation that provides the calculations and methodology used to determine the peak hour ridership.)*

**Existing Capacity (Seats)**
Enter the existing capacity of the current transit system by listing the total number of seats available for riders.

**Added Peak Hour Capacity (Seats)**
This measure allows the TRAC to evaluate the extent to which the proposed project will increase the capacity of the transit service. Enter the increase in the number of seats available added in a single peak hour.

**VMT Reduction**
Enter an estimate of the reduction in vehicle miles traveled within the corridor served by the element.

Most project feasibility studies will readily provide such estimates of a project’s impact and the values provided in these reports can be used. If a Project Sponsor does not have this information, the Department will calculate the VMT reduction based on the Statewide Traffic and Forecasting Model.
(It is the responsibility of the project sponsor to complete all columns for each transit facility entered and attach documentation that provides the calculations and methodology used to determine the VMT reduction.)

**Note:**
Enter one transit facility per row. Add additional rows as necessary by selecting the following icon located in the right margin:

![Click the Plus Sign Below to Add a Row.](image)

<table>
<thead>
<tr>
<th>Freight Type and Route/Name</th>
<th>Ex. Freight Volume/Ex. Facility Capacity Ratio</th>
<th>Reduction in Truck Miles Traveled (tmi)</th>
<th>Freight Capacity Increase (TEUs/day)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Freight Type and Route/Name**
Enter the type of intermodal freight project and the route/name associated with the improvement.

**Existing Freight Volume / Existing Facility Capacity Ratio**
Enter the calculated congestion ratio for intermodal freight element based on the volume of freight it carries, compared with its capacity. Refer to the table below for appropriate inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Road</th>
<th>Port</th>
<th>Rail</th>
<th>Intermodal</th>
</tr>
</thead>
</table>
| Volume | Traffic Volume  
• Autos  
• Trucks  
• Peak hour factor | Port Volume  
• Break bulk tons  
• Containers (TEUs)  
• Dry bulk tons  
• Liquid bulk gallons | Train traffic, expressed as:  
• # of railcars  
• # of trains  
• Train length | Terminal throughput:  
• Containers (TEUs)  
• Other transfer measure (e.g. rail/barge, rail/truck) |
| Capacity | Type of road  
• Number of lanes  
• Speed limit  
• Terrain  
• % truck traffic  
• Etc. | Per hour or per diem capacity expressed in tons, TEUs, etc. | Per hour or per day capacity (expressed in railcars, trains, etc.), as controlled by:  
• # of tracks  
• Signalization  
• At grade crossings | Per hour or per day transfer capacity, for example, containers (TEUs) per day |

(If it is the responsibility of the project sponsor to attach documentation that provides the calculations and methodology used to determine the existing volume to capacity ratio.)
Reduction in Truck Miles Traveled (TMT)

Truck reduction on an individual facility can be easily derived. The volume of freight moving by rail or port can be converted into a number of trucks by equating one twenty-foot equivalent unit (TEU) to one truck. The applicant can use this conversion factor to represent the number of trucks reduced from an adjacent roadway, and calculate this reduction in terms of total truck miles travelled from the facility to the state line.

The other method is to calculate a regional truck traffic reduction, which would be represented as the reduction of truck miles travelled for the area of impact defined by the project applicant. For example, a region could be within an MPO, within the state of Ohio, or within some subarea designated by the project applicant. A feasibility study is required to validate this calculation and will be required as an attachment to the application.

(It is the responsibility of the project sponsor to attach documentation that provides the calculations and methodology used to determine the reduction in TMT.)

Freight Capacity Increase

Enter the total number of TEU’s serviced by the freight facility.

The TRAC will consider increase freight Capacity by capturing the total increased number of TEU’s to be processed through a freight facility. The twenty-foot equivalent unit (often TEU or teu) is an inexact unit of cargo capacity often used to describe the capacity of container ships and container terminals. It is based on the volume of a 20-foot-long (6.1 m) intermodal container, a standard-sized metal box which can be easily transferred between different modes of transportation, such as ships, trains and trucks.

(It is the responsibility of the project sponsor to attach documentation that provides the calculations and methodology used to determine the TEU calculations.)

Note:

Enter one freight facility per row. Add additional rows as necessary by selecting the following icon located in the right margin:
Performed By
Enter the agency name that has completed (or is assigned to complete) the corresponding project phase.

Actual / Projected Start Date
Enter the actual or projected month and year for the beginning of each project phase. It will be assumed that:
- Dates entered before the application date, indicate that the project phase has been started
- Dates entered after the application date, indicate that the project phase has not yet started

Actual / Projected Finish Date
Enter the actual or projected month and year for the completion of each project phase. It will be assumed that:
- Dates entered before the application date, indicate that the project phase has been completed
- Dates entered after the application date, indicate that the project phase is still under development (or not started)

Project Funding: Non-TRAC and Future TRAC

When entering the funding data, the NON-TRAC funds will be entered as follows:

Funding Sources (Non TRAC)

Description
Enter the name of the funding source (MPO, Local, OPWC, etc)
ODOT Funds
Select if the funding source is ODOT (Yes/No)

Federal Earmarks
Select if the funding is a designated Federal Earmark (Yes/No)

Project Phase
Select the project phase which applies to the funding source. Only one funding source may be selected per phase.

Committed Funds
Select if the funds are committed (Yes/No)

Amount
Enter the amount (in dollars) assigned to the funding source

Note:
Enter one funding source per row. Add additional rows as necessary by selecting the following icon located in the right margin:

Once the data is entered, the values will automatically calculate and tabulate in the summary table listed in the following section.

When entering the funding data, the TRAC funds will be entered as follows:

Funding Sources (TRAC)

Fiscal Year
Enter the state fiscal year (which begins July 1) for the beginning of each applicable project phase (e.g. 2012). Please double check that the state fiscal year is correct for the Actual / Projected Begin date on the Project Development table. Project phases that
begin in the month of July (or later) are actually in the next state fiscal year (i.e. July through December 2010 is actually part of state fiscal year 2011).

**Non-TRAC Local Funding**
The table will display the total amount of non-TRAC funding received or committed from local sources (i.e. county, township, city, village, or private) by project phase. These amounts are auto calculated from the values entered in the Funding Sources (Non-TRAC) table.

**Non-TRAC ODOT Funding**
The table will display the total amount of non-TRAC funding received or committed from federal or ODOT sources by project phase. These amounts are auto calculated from the values entered in the Funding Sources (Non-TRAC) table.

**Previous TRAC**
Enter the amount of existing TRAC funding received or committed by project phase.

**New TRAC**
Enter the amount of new TRAC funding requested with this application, by project phase.

**Future TRAC**
Enter the amount of future TRAC funding by project phase that is not being requested with this application, but will be requested at a later date with a future application.

**Total**
The total values will auto calculate based on the data entered for the various phases.

**Funding Notes: NON-TRAC and TRAC Funding**

**Note 1:**
Attach a detailed cost estimate for each project phase that is not yet complete.

**Note 2:**
Please enter the project costs, by source, for each phase of project development along with the calculations used to develop those costs. The TRAC realizes that, depending on the current stage of project development, more or less detail may be available for calculating costs. Simply provide the latest cost information available. It should be noted, however, that the TRAC will expect greatest detail from applicants requesting Tier I (Construction) funding.

Costs for future phases of development should be inflated to the appropriate state fiscal year. Inflation factors can be found on ODOT’s Office of Estimating website at:

[http://www.dot.state.oh.us/Divisions/ConstructionMgt/Estimating/Pages/default.aspx](http://www.dot.state.oh.us/Divisions/ConstructionMgt/Estimating/Pages/default.aspx)
First Name, Last Name
Enter the name of the District Planning and Engineering Administrator

District
Enter the ODOT District

Date
Enter the date

Phone Number
Enter the phone number of the District Planning and Engineering Administrator

Notes:

- Prior to submitting the final application to Central Office, please verify project sponsor has provided a resolution endorsing the submittal of the TRAC application.
- If the resolution is not available August 3, 2012 please coordinate delivery of the resolution no later than August 30, 2012.

MPO Agency
Enter the name of the Metropolitan Planning Organization.

Individual Contacted
Enter the name of the individual acknowledging this application.

Date District Received Email of MPO Acknowledgement
Enter date the District received the email reply from the MPO acknowledging the project

Comments
Enter any remarks or comments that the TRAC should consider with respect to this application.

Notes:

- MPO priorities for TRAC applications should be submitted to ODOT no later than September 15th.
Submission Instructions

In lieu of submitting paper copies to the Department, the following work flow is introduced requesting electronic media and will be implemented for the 2011 TRAC Applications:

**Application Preparation:**

1. The project sponsor prepares the application per the instructions in the user guide.

2. The project sponsor submits the entire application, including supporting information (i.e. documentation, endorsement letters, resolution, and maps) electronically to the District for review. The original application must remain in Excel format while the attachments are required in PDF file format.

**MPO Acknowledgement (If applicable):**

3. Following the District review, the District will send a copy to the MPO (if applicable) requesting acknowledgement of the project(s).

4. The MPO will respond to the District via email (for record) confirming the project.

**District Submission:**

5. Once the project is approved by the District for final submission, the District will copy the project files to the following directory location:

   **Files:**
   - Project Application – Excel format
   - MPO Project Acknowledgement (Email) – PDF
   - Supporting Project Documentation – PDF

   **Directory Location:**
   - O:\Planning\SPPM\Major New\2011 TRAC Applications

   *Note: Please place each application in a separate folder*

6. After the files have been copied to the server, the District will email the TRAC inbox advising the Office of Systems Planning and Program Management that the TRAC applications are ready for processing.

**Application Deadline:**

7. Applications are due to Central Office (including MPO acknowledgement) by the close of business August 3, 2012.